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1 Quick Start Guide 
Complete the following checklist to get started recording with the SM3. 

□ Optionally, check for firmware updates for the SM3. See Section 9.4 for 
instructions. 

□ Install four (4) new high-quality D size alkaline or NiMH batteries in the two 
battery bays. See 3.4 How to Install Internal Batteries. 

□ Insert at least one (1) and up to four (4) memory cards. See 3.6 How to Insert 
and Remove SD Memory Cards.  

□ Slide the power switch down to turn ON internal battery power.  
□ Replace the memory bay cover and hand-tighten the four (4) thumb-screws. 
□ The device powers on and reports its status. After scanning the memory 

cards, the Song Meter Main Menu appears. 
□ Set the date and time. See 3.7 How to Set the Date and Time. 
□ For programs based on sunrise or sunset, set the recorder location and time 

zone. See 3.8 How to Set the Location and Time Zone. 
□ Load a built-in program. See 4.3 How to Load a Built-In Program. 
□ You may modify a built-in program on the recorder, but it is recommended 

to use the SM3 Configurator software on your computer. See Chapter 5. 
□ Mount the recorder in a suitable location for unattended recording. 
□ (Optional) Connect one or two external microphones. The recorder 

automatically detects the microphones and records on those channels. 
□ Press the PROGRAM START button to start the active program on the 

recorder. The SM3 knows when to enter sleep mode to save power and is 
smart enough to wake itself to record for the duration of your deployment. 

□ (Optional) During deployment, press CHECK STATUS to check battery 
voltage or remaining memory card capacity. 

□ Hours, days, or weeks later, press and hold PROGRAM STOP to finish 
recording. Remove the memory cards and review the recordings on your 
analysis workstation or another computer. 

  



SM3 Overview SM3 User Guide 
 

 

page 2   
    BIOACOUSTIC MONITORING SYSTEMS 

2 SM3 Overview 

2.1 Introduction 
The Song Meter SM3 is a cost-effective and reliable solution for the periodic, 
seasonal, or ongoing long-term acoustic monitoring of birds, frogs, and other 
wildlife in any field conditions. 

You can program the device to record when you want for as long as you need. 
Song Meter SM3 has the battery life and memory capacity to record for 
hundreds of hours and can be used outdoors for extended durations lasting 
days, weeks, or even months at a time. Take the rugged heavy-duty portable 
device with you anywhere or mount it in a fixed outdoor location.  

2.2 Updates and Support 
SM3 is field-upgradeable. New features, fixes, and improvements are available in 
firmware updates on our website. The SM3 Configurator software notifies you 
when new firmware is available. See 0  

How to Update the Firmware on page 52. 

2.2.1 How to Join Our Mailing List 
Join our mailing list to receive important news and information about your Song 
Meter and related products, features, and events. 

1. Open a web browser on your computer or mobile device. 
2. Navigate to www.wildlifeacoustics.com. 
3. Click Contact Us. 
4. Click Join Our Mailing List. 
5. Complete the online form and click Add to Mailing List. 

2.2.2 How to Contact Support 
We have full-time support staff ready to assist you.  

■ Email: support2018@wildlifeacoustics.com  
■ In the United States (toll-free): 1-888-733-0200 
■ Outside the United States: +1 978-369-5225 



SM3 User Guide  SM3 Overview 
 

 

 page 3 
BIOACOUSTIC MONITORING SYSTEMS 

2.3 SM3 Visual Tour 

 
 

Song Meter SM3 Product Diagram 

 Mounting Options (Top and Bottom): Constructed of rugged die-cast aluminum and ready for outdoor adventure, use these cutouts to mount your SM3 in 
almost any land environment for a wide range of applications. 

 Channel 0 (left) Built-in Stub Mic: Use this built-in acoustic microphone stub to record audio. 

 Keypad: Press the buttons on this panel and view the menu options on the LCD screen to control the unit. 

 Pressure Vent: This temperature, UV, and water-resistant vent protects the enclosure against condensation, moisture, and heat exposure. 

 Battery Bays: Each bay holds two D batteries. Spring-loaded ergonomic caps turn left to open and right to close. 

 Channel 1 (right) Built-in Stub Mic: Use this built-in acoustic microphone stub to record audio. 
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 Memory Bay: Insert up to four SDHC or SDXC memory cards. Supports cards up to 2 TB (currently 256 GB is the maximum capacity being manufactured). 
Sturdy cover and four easy-grip thumb-screws offer superior protection. 
Remove the cover to access the SD card slots and power switch. 

 Channel 0 Microphone Connector: Optionally connect an SMM-A1 acoustic microphone, or SM3-H1 hydrophone. 

 Channel 1 Microphone Connector: Optionally connect an SMM-A1 acoustic microphone, or SM3-H1 hydrophone. 

 Serial Communication Connector: For the optional GPS time-synch receiver or the available Song Stream remote access hardware. 

 External Power Cable and Audio Output Connector: Use for external batteries (with or without solar panels).  
 

All batteries, memory cards, electronic controls, and the LCD display are mounted 
inside the weather-resistant enclosure to protect them from the elements.  

NOTE: Do not remove the back cover of your recorder. There are no user-serviceable 
parts and removing the cover will void your warranty. When necessary, only remove 
the thumb-screw cover for the memory bay, the two twist-off battery bay covers, and 
the four connector module caps.  

Each of the four connectors provides a weatherproof seal when mated with a 
microphone cable or with the watertight connector caps. Connector caps protect 
the connector port from moisture and debris. Always cap unused connectors. 
Push a cap over each exposed connector until fully seated and secure. 

CAUTION: Gently, but firmly, hand-tighten all covers, caps, and connectors to 
completely secure the device against the environment before use. Do not use tools or 
apply too much pressure since over-tightening could damage the recorder. 
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SM3 LCD Display and Buttons 

 Check Status: Displays the status of the device and illuminates the LCD screen backlight for visibility in dark or low-light environments. Remains 
lit while you continue pressing buttons to operate the device. Turns off 
after 5 seconds of inactivity. 

 LCD Screen: Displays the main menu, status information, and other details when the recorder is awake. Blank when the unit is sleeping to save power. 

 Main Navigation Buttons: Press the directional arrow buttons on this panel and view the menu options on the LCD screen to control the unit. 
Press ▲ Up or ▼ Down to navigate lists of options. Press ► Right to 
advance to the next submenu or value. Press ► Right to save your changes. 
Press ◄ Left to cancel or go back to the last menu item. Press ENTER/MENU 
to navigate menus, select options, and to confirm entries. 

 LED Indicator: Flashes ☼ green once per second when recording. Flashes ☼ 
red once per second when triggers are enabled and the recorder is awake and 
armed, but not currently recording. To disable see Section 6.3. 

 Program Start: Closes any open menus and starts your current program. Depending on the schedule, the device may begin recording immediately or go 
to sleep until a scheduled recording event. If a program is already 
running, pressing this button does nothing.  

 Program Stop: Stops the active program and returns to the main menu. You may need to hold the button for a couple seconds to register in some modes. 
In an open menu, pressing this button does nothing. 
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2.4 The LCD Main Menu  
Refer to the following table when navigating the main menu using the LCD 
screen and directional buttons. 

Recorder Main Menu on the LCD Screen 

Menu Item Description 
Program  
  Load Program Choose a ready-to-run (and customizable) built-in program. 

  Edit Program Edit, add, or delete command lines in a program. 

  Import Program Import a program and associated settings from an SD card. 

  Export Program Export a program and associated settings to an SD card. 

Settings (Optional) You can also use the SM3 Configurator software to 
override the settings on any SM3 device. 

  Sunrise/Sunset Type 
 

Specify one of four recognized methods for calculating the 
sunrise and sunset. 

  Location Specify the location using a prefix, Lat/Long, and time zone. 
      Prefix  Specify a short code to identify recordings from a specific 

program, project, location, or SM3 device; useful to project 
teams with multiple recorders. 

      Latitude Specify the latitude of the SM3 anywhere on the globe in 
degrees north (N) or south (S) of the equator. Latitude is used 
in sunrise and sunset time calculations. 

      Longitude Specify the longitude of the SM3 anywhere on the globe in 
degrees west (W) or east (E) of Greenwich. Longitude is used in 
sunrise and sunset time calculations. 

      Timezone UTC Set the global time zone for your device. 

  Time and Date Set the local date and time for your device. 

  Power Volt Cutoff Specify a minimum voltage from 0.0 to 12.0 volts in 0.1 volt 
increments. If the battery voltage falls below this value, the 
recorder will go to sleep, checking the battery voltage again 
every 24 hours and waking up if it rises above the cutoff. Use 
only with external batteries to protect certain battery types 
from over-discharge. 

  Ch 0 Sensitivity Specify channel 0 microphone sensitivity from 0.0 to -299.9 dB 
in 0.1 dB increments. This value is saved in the recording 
metadata and may be used in future features. 

  Ch 1 Sensitivity Specify channel 1 microphone sensitivity from 0.0 to -299.9 dB 
in 0.1 dB increments. This value is saved in the recording 
metadata and may be used in future features. 

Utilities  

  Export Diagnostics Display useful status and troubleshooting information. 

  Set Factory Default Reset the original device settings. 

  Calibrate Mics Test the sensitivity levels of built-in and connected mics. 

  Format All Cards Erase and reformat all SD cards. The original file system such 
as exFAT or FAT32 is preserved. 
CAUTION: All data on all memory cards is permanently lost and 
cannot be recovered. 

  Firmware Update Update the recorder with a new firmware file in memory slot A. 
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2.5 Basic Operation 
Typical operation of the recorder is represented in the following steps: 

1. Configure the following key requirements of any deployment with your 
specific recording goals in mind: 

a. Power: Insert batteries or connect another power source. 
b. Memory: Insert and format memory cards 
c. Location: Identify an appropriate recording location and establish 

mounting requirements for the duration of the deployment. 

TIP: Use the SM3 Configurator software to estimate memory card requirements and 
power consumption for the program that you plan to run. 

2. Load a program on the recorder. You can choose:  

■ a built-in program already on the recorder 
■ a program you edit on the recorder 

■ a custom program that you design using the SM3 Configurator 
software and then import to the recorder on a memory card.  

3. Mount and secure the recorder. 
4. Press the PROGRAM START button. You can leave the recorder 

unattended after this step. 
5. The recorder sleeps until the next scheduled recording time.  
6. The recorder wakes at the scheduled recording start time, records audio as 

programmed, and saves recordings on one or more memory cards. 
7. After a period of time has elapsed (it might be several days, weeks, or even 

months), return and check on each recorder. To extend a deployment, 
exchange memory cards and install fresh batteries out in the field. 

8. At the end of the deployment, remove the device from its mounted 
location, eject all memory cards, and examine the recorded output. 

9. Clean, re-program, and prepare the recorder for its next assignment. 
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3 SM3 Setup 

3.1 Required Items 
You need at least the following required items to operate the recorder: 

■ Memory Card for installing firmware updates and saving audio 
files. Insert at least one (1) and up to four (4). 

■ Power Source to power the recorder. Choose four (4) D-size 
batteries or an external power cable to an external power source. 

■ Program File to determine when to record and other settings. 
Choose one of the built-in programs or your own custom program. 

3.2 How to Connect Optional Microphones 
Instead of using the integrated stub microphones, you can connect one or two 
external microphones (sold separately). The two microphone connectors for 
channels 0 and 1 mate with our weatherproof cabled acoustic microphone. 

NOTE: With normal outdoor use over time, the foam windscreen will fade to brown. 
Color degradation does not indicate a loss of integrity. Replace the windscreen when 
the foam begins to break down and flake.  

The cabled SMM-A1 acoustic microphone is completely weatherproof and can 
be deployed away from the recorder with cables up to 100 meters in length.  
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■ The connector is keyed and the cable should be seated into the 
connector when oriented correctly and then locked into place by 
turning the locking ring on the microphone or cable  clockwise 
firmly until it stops. For more information, see ■  

Anti-alias filter gain: 

■ From 0 to 0.39 sample rate: ±0.1 dB 
■ At 0.4125 sample rate:   –0.25 dB 
■ At 0.45 sample rate:  –3 dB 
■ At 0.5 sample rate:  –17.5 dB 
■ From 0.55 to 64 sample rate:  –75 dB 

Microphones. 

NOTE: Unauthorized devices may damage the recorder and will void the warranty. 

Both microphones can be extended with available extension cables in 10m and 
50m lengths. All connections are fully waterproof. 

NOTE: Mounting cabled microphones on ungrounded non-conductive masts 
especially in dry and windy conditions, could result in damage to the microphones or 
recorder due to electrostatic build up or lightning. Such damage is not covered under 
warranty so please check with a professional/licensed electrician or installer of outdoor 
antennas, weather instruments or the like for advice suitable to your specific situation. 

 

NOTE: Each cable is shipped with a filter to reduce electromagnetic transmission to 
nearby equipment. This is required to comply with FCC regulations but not installing 
will not adversely affect the performance of the recorder. The ferrite should be installed 
to the cable that attaches to the recorder. The cable is looped through and the ferrite 
snapped shut. A zip tie is included for further securing the filter. 

3.3 How to Turn Power ON or OFF 
You can set the power selection switch to use internal power from four (4) D-size 
alkaine or NiMH batteries or external power through the connector port. The 
power selection switch is located in the memory bay. 

Set the power switch down to turn the unit ON using internal battery power and 
set the power switch up to turn the unit ON using external battery power. The 
unused position functions as OFF. 
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NOTE: Do not turn the power OFF when a recording is in progress. To safely exit from 
recording, press STOP PROGRAM, allow the recorder to return to the main menu, and 
then power down the device. 

 

NOTE: Avoid quickly switching power OFF and then ON again. The unit can interpret 
this sudden loss and restoration of power as an error and may start diagnostics. 

When you turn the power ON the following LCD screen appears: 

2014-Jan-31   09:00:00 
SM3 99999     R1.0.3 
A:   2/128   B:   0/128 
C:   0/128  D:   0/128 

The same information appears when the unit wakes from sleep and starts itself as 
programmed. The startup screen shows the following information: 

■ The current date in YYYY-MMM-DD format. 
■ The current time in HH:MM:SS format. 
■ The model number and serial number for the recorder. 
■ The firmware version. For example, R1.0.3. 
■ For each card slot (A, B, C, and D) the memory used as a fraction of 

the total capacity in GB.  

NOTE: WP will appear in place of the consumed memory for any card with a write-
protection switch ON. 
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3.4 How to Install Internal Batteries 
Set the power switch down to turn the unit ON using internal battery power. 
When not in use, set the switch up to conserve battery power. The up position 
also enables external power, if connected. When no external power exists, 
consider the up position to be OFF. 

With normal operation and high quality alkaline batteries, the SM3 can record up 
to 260 hours. The recorder can be powered from four standard D size disposable 
alkaline batteries or rechargeable NiMH batteries. 

Recording time can be spread over many weeks or months. The SM3 enters a 
very low power state when not recording. 

1. Purchase four (4) new size D batteries of the same type.  

NOTE: Prior to installation, we recommend that you test all batteries with a high-
quality pulse load battery tester such as the ZTS MINI-MBT. 

2. Position your thumb and index finger into opposing bevels of one of the 
twist-off battery bay covers. 

3. Rotate the cover up to 90 degrees  counterclockwise to remove it. 
The spring-loaded cover opens and the old batteries emerge. 

4. Remove the two old batteries and insert two new batteries with the (+) 
positive ends up toward the cover as shown below. 

5. Align the notches and then turn the cover 90 degrees  clockwise, but no 
more than 90 degrees. Delicate force is required to seal the cover. 

6. Repeat for the two batteries in the other battery bay. 
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3.5 How to Use the SM3 with External Power 
With the optional external power cable, the device can safely accept voltages 
from 5-17 volt DC and is intended for 6 or 12 volt external battery systems.  

CAUTION: If you are unfamiliar with configuring external battery and power systems, 
consult with a local installer for assistance. 

 
 

The SM3 provides protection against accidental reverse polarity connections. The 
power cable includes both F2 sized spade connectors and ring terminals to 
attach to a large 6 or 12 volt battery. 

NOTE: Each power cable is shipped with a ferrite filter to reduce electromagnetic 
transmission to nearby equipment. This is required to comply with FCC regulations but 
not installing will not adversely affect the performance of the recorder. The ferrite 
should be installed to the cable that attaches to the recorder. The cable is looped 
through and the ferrite snapped shut. A zip tie is included for further securing the filter. 

Set the power switch up to turn the unit ON using external battery power. When 
not in use, set the switch down to conserve battery power. The down position 
also enables internal power, if connected. When no internal power exists, 
consider the down position to be OFF. 

See 3.10 How to Set the Minimum Battery Voltage for information on setting a 
minimum voltage to prevent damage to lead acid batteries not designed for 
deep discharge. 

3.6 How to Insert and Remove SD Memory Cards 
Insert a card in slot A to update the firmware, import or export a program. 
Replace cards when all storage space is consumed by recordings. You can insert 
up to four (4) cards. 
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NOTE: Be sure the SD card write-protection switch is OFF. The SM3 will not record to a 
write-protected card. 

1. Turn the four thumb-screws  counterclockwise to remove the memory 
bay cover. You may need to clear any debris, sand, or dirt that may have 
accumulated along the sealed edges. 

2. Refer to the embossed letters A, B, C, and D on the cover to identify each 
card slot (also shown below). 

3. To remove a card, lightly push it forward and then feel it release from the 
slot and pull it out. 

4. To insert a card, lightly push it forward until each card is secure. Insert at 
least one card and up to three additional cards.  

5. Turn the four thumb-screws  clockwise to tighten and re-apply the cover. 

 
TIP: Insert multiple SD memory cards to take advantage of failover capabilities. 
If an error occurs on one card, the SM3 can continue writing data on another card. 

If the recorder is unable to write to all available SD cards, on of the following 
errors appear: 

2016-Jan-31 09:00:00 
CARDS FULL, ERROR, or DIRTY 
0: 24000  --- ------- 
1: 24000  --- ------- 

A card marked "DIRTY" indicates that a critical write operation affecting the file 
system (typically at the very beginning or ending of a recording) was interrupted 
due to an unrecoverable error or power failure. The Song Meter SM3 will avoid 
further use of a "DIRTY" card to avoid further card corruption that could lead to 
unrecoverable data loss. "ERROR" indicates some other flash card problems. The 
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"DIRTY" condition can be cleared by accessing (writing) the card on your host 
computer or by reformatting the card using the SM3 on-board formatting utility. 

NOTE: During a recording, do not remove memory cards. Replace cards only when the 
unit is in sleep mode or when power is OFF. In some cases, removing and/or inserting 
a memory card while the device is recording (often called hot-swapping) may cause the 
recorder to restart. 

3.7 How to Set the Date and Time 
You can set the current date and time for the recorder.  

NOTE: The recorder does not automatically adjust for daylight savings time. 

As you adjust the month and day, the unit calculates and displays the next 
sunrise and sunset times for your reference. 

1. At the Song Meter Main Menu, select Settings, and press ENTER/MENU. 
2. Select Time and Date and press ENTER/MENU. 

The date and time appear on one line in the following format: 
 YYYY-MMM-DD    HH:MM:SS 
For example:  

2015-Oct-22    20:17:45 

3. Press ENTER/MENU or ► Right. 
The cursor flashes on the last digit of the year.  

4. To adjust the year, press ▲ Up or ▼ Down. 
5. Press ENTER/MENU or ► Right to set the month. 
6. To adjust the month, press ▲ Up or ▼ Down. 
7. Press ENTER/MENU or ► Right to set the numeric day of the month. 
8. To adjust the date, press ▲ Up or ▼ Down. 
9. Press ENTER/MENU or ► Right to set the hour. 
10. To adjust the hour, press ▲ Up or ▼ Down. 
11. Press ENTER/MENU or ► Right to set the minute. 
12. To adjust the minutes, press ▲ Up or ▼ Down. 
13. Press ENTER/MENU or ► Right to set the second. 
14. To adjust the seconds, press ▲ Up or ▼ Down. 

At this point in the procedure, you have explored all of the options for 
changing date and time values. 

15. (Optional) To go back and make any changes, press ◄Left.  
Press ►Right to return to the seconds value. 

16. Press ENTER/MENU or ►Right to apply your changes. The cursor moves 
back to the first digit of the year and then applies your changes. 

17. Press ◄ Left two times to return to the main menu. 
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NOTE: To accelerate the pace when adjusting the date and time values, press and 
continue to hold down the ▲ Up or ▼ Down arrow buttons. 

3.8 How to Set the Location and Time Zone 
The selections you make for latitude, longitude, and time zone (in conjunction 
with the sunset/sunrise solar calculation type) enable the recorder to make 
adjustments and determine a specific sunrise and sunset time for each day. 

NOTE: When you import a program with custom coordinates, a new prefix, UTC 
settings, and other check box items from the Configuration Settings section of the 
SM3 Configurator software, the new values from the program automatically replace the 
original settings on the recorder. 

You can specify the local time zone (as used to set the clock) in hours relative to 
UTC (Universal Time Coordinated). Half and quarter time zones (:00, :15, :30, :45) 
are also supported. 

NOTE: The recorder does not automatically adjust for daylight savings time. 

Use the following steps to set the latitude, longitude, and time zone. 

1. At the Song Meter Main Menu, select Settings, and press ENTER/MENU. 
2. Select Location and press ENTER/MENU. 
3. On the Location Settings screen, press ▼ Down to select Latitude. 

a. Press ► Right. 
b. To enter degrees of latitude north of the equator, press ▲ Up. 
c. To enter degrees of latitude south of the equator, press ▼ Down. 
d. Press ► Right to enter minutes. 
e. Press ENTER/MENU. 

4. On the Location Settings screen, press ▼Down to select Longitude. 
a. Press ► Right. 
b. To enter degrees of longitude west of the prime meridian, press ▲ Up. 
c. To enter degrees of longitude east of the prime meridian, press ▼ Down. 
d. Press ► Right to enter minutes. 
e. Press ENTER/MENU. 

5. On the Location Settings screen, press ▼ Down to select Timezone. 
a. Press ► Right. 
b. To specify one of the time zones ahead of 0:00 UTC, press ▲ Up. 
c. To specify one of the time zones behind 0:00 UTC, press ▼ Down. 
d. Press ► Right to specify additional 15-minute increments adopted by 

certain regions between two time zones. 
e. Press ENTER/MENU. 
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3.9 How to Set the Solar Calculation Method 
Song Meter can be used to schedule recordings relative to sunrise and sunset 
times, and adjusts these times as they change during the year. You can choose 
from four different recognized methods of calculating the sunrise and sunset. 

1. At the Song Meter Main Menu, select Settings, and press ENTER/MENU. 
2. Select Sunrise/Sunset Type and press ENTER/MENU. 
3. At the Sunrise/Sunset Type menu, the Solar item is already selected. 
4. Press ► Right to advance to the current solar calculation method. 
5. Press ▲ Up or ▼ Down to cycle through the following list of choices: 

■ Sunrise/set: The sun is just below the horizon. 
■ Civil: The sun is 6 degrees below the horizon. 
■ Nautical: The sun is 12 degrees below the horizon. 
■ Astronomical: The sun is 18 degrees below the horizon. 

6. The calculated sunrise and sunset times for the method that you select 
appear as if they were occurring today. For example: 

Sunrise/Sunset Type 
-Solar  Nautical 
Rise 05:12   Set 18:57 

7. Press ENTER/MENU to save your changes. 
8. Press ◄ Left to return to the Song Meter Settings menu. 

NOTE: Sunrise and sunset calculations require other settings including your location 
(latitude and longitude) and time zone. 

3.10 How to Set the Minimum Battery Voltage 
The Power Volt Cutoff setting allows you to specify a minimum voltage from 0.0 
to 12.0 volts in 0.1 volt increments. If voltage falls below this value in a 24-hour 
period, the program is suspended. 

This allows a minimum voltage to be set such that certain types of external 
batteries such as some types of lead acid batteries will not be damaged by over-
discharge. This should not be used with internal alkaline batteries. These batteries 
are not rechargeable and are not damaged by complete discharge. Adding a 
minimum voltage with these types of batteries will result in decreased battery life 
as the recorder will suspend operation prematurely.  
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3.11 How to set the Microphone Sensitivity 
The Ch 0 and Ch 1 Sensitivity settings should be ignored. These do not need to 
be set for the recorder to function properly and they do not set sensitivity. They 
allow known microphone sensitivities to be entered, which will be saved in the 
recording meta-data for use in undeveloped features.  

3.12 How to Change the Prefix for Recorded Files 
You can specify a filename prefix of up to 12 characters that appears in the 
recording file names to label recordings made by each SM3. The prefix uniquely 
identifies each Song Meter in the field. For example, you can use a different prefix 
to tag recordings by location. It is also possible to use the same prefix to tag 
recordings by season or project name. 

NOTE: The prefix can only contain capital letters, numbers, and hyphens. 

The default prefix, set by the hardware, is the serial number of the SM3 recorder; 
however, you can edit this value on each device or override in the program file 
that you create using the SM3 Configurator software. 

1. At the Song Meter Main Menu, select Settings, and press ENTER/MENU. 
2. Select Location and press ENTER/MENU. 
3. At the Location Settings menu, select Prefix, and press ► Right. 
4. Specify a 1 to 12 character prefix: 

a. At the first position, press ▲ Up to cycle through the alphabetic 
characters A to Z. Press ▼ Down to cycle through the numbers 9 to 0. 
You can also select a hyphen. 

b. Press ► Right to advance to the next position in the prefix and repeat 
the previous step. 

3.13 How to Verify the Device and Audio Settings 
A quick way to test the device is to load the built-in 24-hour recording program. 
Complete the following steps to verify the recorder is working. 

1. Press CHECK STATUS two times in sequence. 
2. Verify that Mic0 and Mic1 show any optional attached external 

microphones. 
3. Perform the calibration procedure to verify that the microphones are 

picking up sound. See 9.3 How to Measure Microphone Sensitivity. 
4. Insert an SD card into one of the memory slots. 
5. Load the 24-hour recording program and press PROGRAM START. 
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6. Make audible sounds (talk or clap hands). 
7. After a few minutes of recording time, press PROGRAM STOP. 
8. Remove the memory card and insert it in another computer, laptop, or 

mobile device.  
9. Play the recorded .wac or .wav file. The filename should include the prefix 

set on the device or set by the SM3 Configurator if you loaded a custom 
program. For example: 
 
ARIZONA-1234_0+1_20160104_152209.wav 

3.14 How to Mount the Recorder 
Constructed of rugged die-cast powder-coated aluminum, the SM3 is weather-
resistant to the specifications given in Chapter 10: SM3 Specifications. Use the 
top and bottom mounting receptacles for attaching the unit with cables, screws, 
radiator clamps, bungee cords, or other fasteners. 

 

3.15 How to Check the Status of the Recorder 
Use the following procedure to check the status of the recorder. Always perform 
this procedure to check the status of the recorder and memory cards before a 
deployment.  

1. Press and hold down the CHECK STATUS button until the unit responds. 
This may take several seconds. 

2. The LCD screen backlight illuminates and an initial status screen appears.  
2015-Jan-31  09:03:48 
SM3 00123  R1.0.3 
A:  2/128  B:  0/128 
C:  0/128  D:  EMPTY 

NOTE: WP will appear in place of the consumed memory for any card with a write-
protection switch ON. 

3. After a short delay, the screen resets and the backlight turns off to save 
power. 

4. Press CHECK STATUS a second time before the unit goes back to sleep 
and a second status screen appears after the first one. This screen shows 
the current battery voltage and temperature.  
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a. In this example, the unit is not currently recording to an external 
microphone on channel 0; however, it has been programmed to start 
recording at the date and time shown:  
Bat  5.9V  Temp 16.70 
Mic0: A1  Mic1: NA 
Next recording at:   
2016-Feb-01  05:30:00 

b. In this example, the unit is currently recording on the internal 
microphone on channel 1 at a sound level of 41.1 dB.  
Bat  5.9V  Temp 16.70 
Mic0:  NA  Mic1: NA 
0:-------------------/-- 
1:*         -41.1dB/-- 

NOTE: New alkaline batteries should report 6 or more volts. The screen also shows the 
internal temperature of the recorder in degrees Celsius. This is intended for diagnostics 
and not to be an accurate measure of outside air temperature. 

3.16 Temperature Sensor 
The recorder includes an integrated temperature sensor to log temperatures 
inside the enclosure. This is intended for diagnostics only. Heat from the circuit 
and/or heat from sun on the enclosure both can significantly increase the 
temperature reading above ambient air conditions. 

3.17 The Backup Clock Battery 
The backup clock battery for this device is not user-accessible. The clock battery 
is pre-installed in all new devices and should last up to eight (8) years with 
normal use. During normal operation the D cell batteries (or external power 
source when used) supplies power to the clock. The internal battery is only a 
backup to preserve the time settings if there is no main power or the SM3 is 
turned OFF. The unit will still operate properly with a dead clock battery; 
however, the clock will need to be reset if the D cells are removed or are 
depleted. 

3.18 How to Connect the GPS Time-Synch Option 
Use the optional GPS time-synch receiver to calculate the location of wildlife 
signals from multiple SM3 units and multiple recordings. The optional GPS time-
synch receiver synchronizes the SM3 clock to the GPS time base for extremely 
accurate time stamping on all your recordings. It also logs the path and location 
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of the recorder when a recording was made. The GPS coordinates are logged in a 
file on the SD card and in metadata inside each recording file. 

NOTE: The GPS receiver does not synchronize recordings when using recording 
triggers. You must record continuously to maintain synchronization. 

Crystal oscillators used in clocks and electronics, including the SM3, have 
frequencies that vary over time. The SM3 clock uses a temperature-compensated 
crystal with very low drift (< 3.5 ppm); however, clock drift of several milliseconds 
per hour can still occur.  

The SM3 GPS receiver can synchronize your recordings across multiple recorders 
to within one millisecond. Arrange multiple time-synchronized recorders to 
triangulate a source location by measuring the relative time-of-arrival of sound 
waves as they travel. 

NOTE: The GPS Time Synch Option provides synchronized recordings, but additional 
third-party tools are needed to determine the time of arrival of a particular signal to 
each microphone and calculate the position of the source. 

1. Order an SM3 with this option or place a new order for the GPS time-
synch receiver for the SM3. 

2. The Location Settings are automatically set by the GPS. 

NOTE: Although the navigation steps are the same, the Location Settings coordinates 
are now read-only. You cannot change them. This change in location may affect the 
calculated sunrise and sunset times when using advanced scheduling commands. 

3. To verify, perform the steps in 3.8 How to Set the Location and Time Zone. 
4. Unpack the optional GPS time-synch receiver and the included 5-meter 

cable. 
5. Remove the cap over the serial communication connector, the third 

connector from the top in the series of four ports in the connector module.  
6. Attach, rotate, and secure the cable to the serial communication connector 

to make a weatherproof seal. 
7. Position the receiver where a reliable GPS signal can be received. 

NOTE: It can be difficult to acquire a GPS signal in thick vegetation. 

8. The SM3 automatically detects the presence of the GPS receiver. When the 
SM3 wakes up, the GPS receiver is powered up. A question mark (?) blinks 
between the date and time to indicate that the GPS receiver is attempting 
to acquire global positioning satellite data. 

2014-Jan-31 ? 09:00:00 
SM3 99999     R1.0.0 
A:  2/128    B:   0/128 
C:  0/128  D:   0/128 
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9. When the GPS receiver has successfully acquired satellite transmission, the 
question mark changes to an exclamation point (!) and then a dollar sign 
($) indicating that the clock is now synchronized. 

10. The SM3 clock automatically adjusts to GPS time.  

3.18.1 Details of Operation 
The SM3 wakes up 150 seconds before a scheduled recording to give the GPS 
time to acquire satellites. (Without the GPS option, the SM3 wakes up 30 seconds 
before a scheduled recording.) The recording starts within a fraction of a 
millisecond of GPS time. If the GPS has been used recently in the area, the 
position fix will take under a minute. If a significant amount of time has elapsed 
or the GPS has been shipped some distance, the GPS must download new tables. 
In this case the first position fix can take up to 40 minutes, but subsequent fixes 
should still occur in under a minute. 

While making the recording, the SM3 automatically makes small adjustments by 
inserting or removing samples as needed to maintain synchronization with the 
GPS clock to within one millisecond. Additionally, if recording to a .wac file, the 
latitude and longitude coordinates are stored approximately every second.  This 
data can then be viewed with SongScope or extracted by Kaleidoscope software. 

NOTE: The GPS receiver does not synchronize recordings when using triggered WAV 
mode.  Synchronization is only provided for non-triggered WAV, non-triggered WAC, 
or triggered WAC. 

If synchronization was acquired and maintained for the duration of the recording, 
the underscore character in the filename between the date and time changes to 
a dollar sign as shown in the following filename examples:   

ARIZONA-1234_0+1_20160104_152209.wav 
ARIZONA-1234_0+1_20160104$152209.wav 

This is how you can tell if the entire recording was successfully synchronized.  If 
the GPS signal was not successfully acquired before the recording started or was 
lost at any point during the recording for more than a few seconds, the $ does 
not appear in the filename. 

3.18.2 Extracting Location Information 
If the recordings are in .wac file mode, location information can be viewed in 
Song Scope (version 3.4 or later) by dragging the curser around the spectrogram. 
If the recordings are in .wac and converted to .wav in Kaleidoscope, the GPS data 
can be extracted into either a comma-separated values (.csv) file or Google .kml 
file. Select the Extract GPS track check box on the GPS tab and select your 
format. The resulting file will show waypoints for the end of each triggered event.  

If extracting from .wac format, you can additionally select a frequency in seconds 
to show path information.  
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You can also view the GPS locations per recording period and clock drift in the 
Summary file, generated by the SM3 while recording. The drift is logged as time 
delta from the SM3 real time clock (RTC). Negative numbers means the RTC is 
slow relative to GPS while positive numbers mean the RTC is fast relative to GPS. 
This file can be used for special cases, where drift of unsynchronized recordings 
between two synchronized recordings can be estimated and corrected. 

3.18.3 Power Considerations 
The GPS receiver consumes about 500 mW of additional current. This can result 
in a reduction of about 65% of the estimated battery life for audio recordings. 
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4 Programs 

4.1 Introduction 
This section describes how to work with programs on the recorder using the LCD 
screen main menu and keypad. 

The operating behavior of the SM3 is controlled by a program file. You can 
create and save multiple programs; however, you can only load one active 
program at a time on the recorder. You can load one of the built-in programs, 
import a program on an SD card, or create and edit your own program using the 
recorder or SM3 Configurator software. The program defines the recording 
schedule, commands, and all parameters. Out of the box, the SM3 does not have 
any program loaded and one must be loaded using one of the above methods.  

4.2 Recording Basics 
Song Meter can record in mono using either channel 0 or channel 1, or in stereo 
using both channels. Recordings can be made using standard .wav file format or 
compressed .wac file format. By default, compression is turned off and the audio 
files are stored as uncompressed .wav files. If you enable compression to reduce 
file size, the SM3 stores the audio files in the proprietary Wildlife Acoustics Audio 
Compression (WAC) file format with a .wac filename extension. 

The WAC0 format is a lossless audio compression format designed to provide 
efficient compression for typical open microphone field recordings. On average, 
.wac files are 40% smaller than uncompressed .wav files. Actual compression 
rates vary depending on the sounds picked up by the microphones. 

NOTE: As memory card capacities expand and prices fall, the value of the 
compressed .wac file format decreases. Compression consumes more processing 
power. For most wildlife recording projects, we recommend .wav format. 

4.3 How to Load a Built-In Program 
You can load, edit, and run built-in programs directly on your recorder. The built-
in programs are designed to implement the most popular recording schedules. 
Once loaded, the program will remain on the SM3 even without power. You also 
have the flexibility to edit one or more lines in the built-in programs to satisfy 
your specific objectives. 
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1. At the Song Meter Main Menu, select Program, and press ENTER/MENU. 
2. Select Load Program and press ENTER/MENU. 
3. On the Select Program screen, press ▲ Up or ▼Down to select one of 

the following built-in programs: 
Sunrise to Sunset 
Sunset to Sunrise 
Sunset - Sunrise ZC 
Dawn for 3 hours 
Dusk for 3 hours 
30min on/30min off 
24 hours 

NOTE: For sunset to sunrise or sunrise to sunset programs, set the recorder location and 
time zone. See 3.8 How to Set the Location and Time Zone.  

NOTE: The Sunset – Sunrise ZC program is for SM3BAT units only; it won't run on SM3. 

4. Press ENTER/MENU. The following message appears: 
Program loaded 

5. The program that you selected is loaded onto the recorder. Next, you can 
perform any of the following actions: 
■ Edit the program. 
■ Export the program to an SD card. 
■ Start the program. 

4.4 How to Edit a Program 
Use this procedure to edit the currently active program directly on the recorder 
using the LCD screen and buttons. To learn more about each command and 
available settings, see 6.3 Program Commands. 

1. At the Song Meter Main Menu, select Program, and press ENTER/MENU. 
2. Load or import a program. 
3. Select Edit Program and press ENTER/MENU. 
4. Press ▼ Down to select a line in the program. 
5. To edit the line, press ► Right to advance to the command or value and 

then press ▲ Up or ▼ Down to make adjustments. When finished, press 
◄ Left or ENTER/MENU. 

6. To add or insert a line: 
a. Press ▲ Up or ▼ Down to select the <Add/Insert> entry on the last 

line of the program and press ENTER/MENU. A new line appears at 
the bottom of the program. 
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b. Press ◄ Left and then press ▲ Up or ▼ Down to change the line 
number for the new line. Press ENTER/MENU to confirm the line 
number. 

c. To edit the new line, press ► Right to advance to the command or 
value and press ▲ Up or ▼ Down to make adjustments. When 
finished editing, press ► Right or ENTER/MENU. 

7. To delete a line: 
a. Press ▲ Up or ▼ Down to select the line you want to delete. 
b. Press ► Right to advance to the command for that line. 
c. Press ▲ Up or ▼ Down until the <Delete> command appears. 
d. Press ENTER/MENU. The line is removed and all higher lines cascade 

down in sequence by one line. 
8. When finished editing all lines, press ◄ Left.  
9. Any program errors appear. Repeat these steps to resolve the errors or 

press ◄ Left to ignore. Press ▼ Down to view the next problem. 
Press ▼ Down after the last problem to return to the Program menu. To 
return to the Program menu before reviewing all the problems, press ◄ 
Left. 

10. When no errors exist, the following message appears: 
Program edit OK 

4.5 How to Create a Program On the Recorder 
You can create a new program from scratch at line 1 using the recorder.  

1. At the Song Meter Main Menu, select Program, and press ENTER/MENU. 
2. Press ▼ Down, select Edit Program, and then press ENTER/MENU. 
3. The following screen appears: 

Edit Program 
-01  <Add/Insert> 

4. Press ► Right and then press ▲ Up or ▼ Down to cycle through the 
available program commands. 

5. Select a command and press ► Right. Press ▲ Up or ▼ Down to adjust 
the associated parameters for the command.  

6. Press ► Right to complete line 01 and repeat these steps for line 02 and 
each subsequent line. 

7. When finished, press ◄ Left to check the program. Any program errors or 
warnings appear. Press ▼ Down to cycle through multiple errors or 
warnings. 

8. Press ◄ Left to exit. 
9. Edit the program to resolve any errors. 
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4.6 How to Export a Program 
You can export the current program to an SD card in slot A.  

1. At the Song Meter Main Menu, select Program, and press ENTER/MENU. 
2. Press ▼Down to select Export Program and press ENTER/MENU. The 

following message appears: 
Program exported 

3. Eject the SD card in slot A and examine the top-level folder contents on a 
computer or laptop. The exported file name is always the recorder prefix 
with the .PGM extension. For example: 
 
SM3001234.PGM 

 
The default prefix is the device serial number. You can specify a new prefix 
on the recorder or in a custom program.  

NOTE: If a file with that name already exists on the SD card, it is overwritten.  

4.7 How to Import a Program 
Use this procedure after saving a custom program to the root or top-level 
directory of an SD card from another SM3 recorder or from the SM3 
Configurator. You can import a program file (.PGM) from the SD card in slot A. 

1. At the Song Meter Main Menu, select Program, and press ENTER/MENU. 
2. Select Import Program and press ENTER/MENU. 
3. At the Select program file prompt, press ▲ Up or ▼Down to select a 

program file on the memory card in slot A. 
4. Press ENTER/MENU.  
5. If no warnings or errors exist, the following message appears: 

Program imported 

6. If a warning or error exists, the line number and a short notification appear 
as shown in the following example: 

Program error 
Line 14 
No GAIN cmd  

a. Press ◄ Left to return to the list of available programs and choose a 
different one.  



SM3 User Guide  Programs 
 

 

 page 27 
BIOACOUSTIC MONITORING SYSTEMS 

b. Press ◄ Left again to exit and go back to the Program menu. Edit 
the program using the recorder or SM3 Configurator software. Try the 
import again. Select Import Program when the program is error-free. 

7. The program that you select is imported onto the recorder and loaded as 
the active program. Press ◄ Left to return to the Program menu. 

8. You can perform any of the following actions on the imported active 
program: 
■ Edit the program. 
■ Export the program to an SD card. 
■ Start the program. 

4.8 How to Start a Program 
Follow these steps to start the current program. The current program is the last 
one you loaded or imported.  

1. Press PROGRAM START.  
2. Errors or warnings may appear. For example: 

Program warning 
Line 12 
No microphones 

3. Press ▼ Down to advance to the next error or warning, if any.  
4. If you do not press any buttons for 60 seconds, the Program Checker exits. 

a. If there are any errors, go back to the main menu. Edit the program 
and fix the errors. 

b. If there are only warnings, the program starts running. Editing the 
program or attaching a missing item such as a microphone are 
optional steps that can often be used to resolve warnings. 

5. Press PROGRAM START again to run the revised program. 
6. If the scheduled start time is more than one minute into the future (three 

minutes if using the GPS option), the recorder enters sleep mode to 
conserve power. The SM3 wakes up 30 seconds before the scheduled 
recording start time. The device automatically wakes 2 minutes early when 
the GPS time-synch receiver option is detected and wakes 3 minutes early 
when hydrophones are installed.  
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NOTE: If you use an AT TIME, AT SRIS or AT SSET command that is within a daily 
repeating loop, and start the program after that time of day, the recorder will assume 
you wish to record starting at the previously occurring sunset, sunrise or time, and 
begin recording immediately. 

For example, if you have a program that starts with AT TIME 16:00:00 and records for 3 
hours, but you start the program at 17:00:00, the recorder will not wait until 16:00:00 
the next day, but instead will start recording immediately and record the remaining 
two hours of the days’ schedule. 

If you start a program with an AT TIME command that is not contained in a daily loop 
or the program starts with an AT DATE command, then the recorder will wait until the 
next specified time or date. 

4.9 How to Stop a Program 
Press and hold the PROGRAM STOP button while a program is running or 
scheduled to run to stop it from continuing. You may have to hold the button for 
several seconds. If you stop a running program, the recorded output (up until 
recording was stopped) is saved. 
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5 SM3 Configurator Software 

5.1 Introduction 
Use the SM3 Configurator software to create and edit recording programs for any 
SM3 series recorder. The software is available for Microsoft Windows, Apple Mac 
OSX, and Red Hat Linux.  

You can also use this application to perform the following tasks: 

■ Estimate battery life and memory capacity for recording deployments. 
■ Open a recording to view the commands and settings used in the original 

program that captured it. 
■ Edit and save your own versions of a program and use them on future 

deployments to one or more SM3 acoustic or ultrasonic recorders.  

5.2 How to Install the SM3 Configurator 
Follow these steps to download and install the SM3 Configurator software. 

1. Navigate to www.wildlifeacoustics.com/support/download-software. 
2. Find the setup file appropriate for your operating system. 
3. Download the file and follow the installation instructions. 

5.3 How to Open the SM3 Configurator 
On Microsoft Windows computers, the program is located in the Wildlife 
Acoustics folder in Program Files. The installer creates shortcuts on your 
desktop and in the Start menu. On Apple Mac OSX computers, the program 
should be moved to the Applications folder. 
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5.4 SM3 Configurator User Interface  

 
SM3 Configurator Software 

 File and Help Menus: Click the File menu to load a sample program, open one of your own programs, save a program, or exit. Click the Help menu and 
choose About to view the currently installed version number of the utility. 

 Configuration Settings: Adjust the settings in this section to override the settings on any recorder.  

 Program: Enter your choice of commands and adjust their parameters to create, edit, and save your own programs. 

 Deployment Scenario: Gauge the impact of your deployment settings on battery power, memory capacity, and the recording schedule. 

 Scrollable Calendar View: Use this section to explore the recording schedule, estimated battery life, and memory card requirements of your 
program. Black bars represent successful recordings; purple bars require 
more memory; and red bars represent insufficient power. Blue and yellow 
shading indicates night and day based on program settings. 

 Status Bar: When you position your mouse pointer over an entry in the schedule, the status bar displays details about that point in the program. 
From left to right, it shows the recording date, time, duration, power 
consumption, memory card utilization, the running total number of sound 
files, recording type, channels, file format, and sample rate. 
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5.5 How to Create a Program (SM3 Configurator) 
Although you can create a new program starting at line one, as a time-saving 
best practice use this procedure to create a new program from one of the sample 
programs provided as a template. 

1. Open the SM3 Configurator software application. 
2. Click the File menu and choose one of the sample programs: 

■ Sunrise to Sunset 
■ Sunset to Sunrise 
■ Sunset - Sunrise ZC (SM3BAT models only) 
■ Dawn for 3 hours 
■ Dusk for 3 hours 
■ 30min on/30min off 
■ 24 hours 

3. In the Program section, examine each line of the program. Use the drop-
down value lists to edit fields. You can use the mouse or press the Tab key 
to advance to the next field. Press Shift+Tab to go back to the previous 
field. Press the arrow keys on your keyboard to cycle through value lists.  

4. To change a command in any line, select another command from the list. 
5. The last line in a program is empty and shows <Choose> in its command 

field ready for you to add a new line.  
6. To insert a new line, click a line number. 
7. To remove a line, select <Delete> in the command field.  
8. (Optional) Adjust the Configuration Settings section to override the 

settings in the recorder. 
9. (Optional) Adjust the Deployment Scenario section to estimate a 

recording schedule. 
10. Resolve any errors that appear below the Program section. 
11. Click the File menu and choose Save. 

a. Save the program to your computer to continue editing it or to use it 
as a template for future programs. 

b. Save the program to an SD card to import it onto one or more 
recorders in the field. 

5.6 How to Adjust Configuration Settings 
Select check boxes in the Configuration Settings section to override any values 
already set on an individual SM3 unit when you import your program. For 
example, select the Prefix check box and enter a new prefix for a location or 
project. All the settings in this section are documented elsewhere in this guide. 
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5.7 How to Adjust Deployment Scenario Settings 
Use the fields in the Deployment Scenario section to estimate the recording 
schedule for the currently open program in the calendar view. 

1. Load a sample program or a custom program. 
2. In the Deployment Scenario section, choose the target Song Meter 

device for this program: 
■ SM3: This model has two built-in internal microphones. 
■ SM3BAT: This model supports ultrasonic sample rates and zero 

crossing recording. It does not have built-in acoustic microphones. 
3. In the Start fields enter the date and time in the following format: 

 
DD/MM/YYYY   HH:MM:SS 
 

4. In the series of four (4) fields labeled A, B, C, and D, select the estimated 
capacity of the memory card you plan to insert in each slot. 

5. In the Mic 0 field, select the type of microphone you plan to use on the 
channel 0 (left). For mono, specify just one microphone. If you do not 
select a microphone, errors will be shown in the program.  Selecting the 
proper microphone also makes the battery longevity estimate more 
accurate as the external microphones do use more power. 

6. In the Mic 1 field, select your microphone on channel 1 (right).  
7. In the Trig Ratio (%) field, indicate the percentage of time during 

recording periods that a given microphone will be triggered. This only 
applies to triggered recordings. The default value of 10% is a good 
estimate for bat recordings. Adjust as needed based on past experience 
with your specific recording conditions. 

8. In the Power (Wh) field, enter the anticipated battery energy to be used 
for recordings made from this program in watt-hours. Wh can be 
calculated by multiplying the battery capacity in amp hours (divide by 
1000 if given in milliamp hours) by the total voltage of the batteries. Total 
voltage is the sum of all the battery cells. For example, 4 internal alkaline D 
size batteries at 1.5 V each with a capacity of 12,000 milliamp hours would 
be 12,000 divided by 1,000 = 12 amp hours. And 1.5 V times 4 batteries = 
6 V.  Multiplying 6 V times 12 amp hours gives us 72 Wh. 

NOTE: Using a 12V external battery is about 85% efficient as compared to 6V. Multiply 
your calculated watt-hours by 0.85 before entering into the configurator to 
appropriately derate the power for more accurate longevity calculations. 

9. Examine the recording calendar and make any adjustments. 
10. Click the File menu and choose Save. Save the .PGM file to a memory card 

and insert it in slot A. 
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11. Import the program onto the recorder. See 4.7 How to Import a Program 
on page 26. 

5.8 How to Use the Scrollable Calendar View 
The scrollable view on the lower portion of the application window shows the 
recording schedule for over a year from the Start date and time in the 
Deployment Scenario section. Recording periods are shown with black bars. 
Blue shaded areas represent nighttime and yellow shaded areas represent 
daytime based on sunrise/sunset calculations determined by the time zone 
(hours relative to UTC), latitude, and longitude specified in the Configuration 
Settings section. The SM3 breaks up long recordings so they do not exceed the 
2.0 GB file size limitation.  

The scrollable view also illustrates when Song Meter is likely to stop recording 
after running out of memory storage or battery power. Running out of memory 
storage is shown with recordings in purple, and running out of power is shown 
with recordings in red. These are estimates based on the memory card and 
battery capacity specified in the Deployment Scenario section. Actual 
performance is subject to variations in memory card and battery manufacturers 
and numerous other factors such as temperature or battery charging method. 
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6 Developing Custom Programs 
TIP: Start by loading one of the sample programs and then make adjustments to 
create your own custom programs. 

6.1 Loops 
An essential logical structure in any computer program, a loop repeats a task, 
state, or condition until a necessary event occurs. For example, you need a 
program that waits, and continues to wait until sunrise; and then you want it to 
record, and repeat that action, recording over and over (we call that a loop) until 
15 minutes before sunset. 

Loops are programmed by using pairs of REPEAT and UNT commands, nested 
to any depth. Loops have an explicit ending condition, such as a date for an 
UNTDATE command or a count for an UNTCOUNT command. In addition, 
loops have an implicit ending time, inherited from any enclosing loops. The 
implicit ending time is the earliest of all the enclosing loop ending times. In other 
words, the ending condition of a loop is either its own ending condition or the 
implicit ending time, whichever occurs first. 

RECORD and PLAY commands likewise inherit an implicit ending time from any 
enclosing loops, perhaps causing a RECORD command to finish earlier than 
indicated by its own duration parameter or causing a PLAY command to not play 
its file at all. 

UNTCOUNT loops do not have an ending time of their own, although they do 
pass along any implicit ending time that they inherit. If a program contains just 
one loop, a REPEAT/UNTCOUNT loop, with a RECORD command inside that 
loop, then the RECORD command will always run for its full duration, and the 
loop will end after the specified count of iterations. 

6.2 AUTO Values 
Instead of an explicit value, some commands allow a value of AUTO for one or 
more of their parameters. Examples include the channel 0 and 1 parameters of 
the GAIN command and the FS command channels and rates. When AUTO 
values are set, the recorder automatically chooses appropriate values based on 
its current configuration. For example, AUTO settings tell the recorder to use the 
external SMM-A1 microphone if it is attached rather than the built in 
microphone.  
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All the built-in sample programs use AUTO values to help you get started. The 
AUTO behavior of each command is specified in the relevant section below. 

6.3 Program Commands 
Use the following commands to create programs for your specific recording 
needs. A program can contain up to 99 command lines.  

NOTE: Some commands listed in this section refer to sunrise or sunset in a general 
sense and depend on them in program calculations. The recorder recognizes different 
methods for calculating precise sunrise and sunset times. To specify a method and 
view the next available sunrise and sunset times, select Sunrise/Sunset Type in the 
Settings menu. 

HPF {OFF,220HZ,1KHZ,16KHZ} {OFF,200HZ,1KHZ,16KHZ} 
This sets the channel 0 and 1 analog high pass filter. A high pass filter only 
allows signals higher than the specified frequency to be recorded. For 
recording very low frequency sounds such as elephants, set this to OFF. 
Otherwise it is useful to cut down on wind and anthropogenic noise and 
should be set to at least 220 Hz. If your signals of interest are higher, it is 
better to go even higher. 

The filter is a two pole filter, meaning it attenuates sounds at 12dB per 
octave. So if set to 1.0 kHz, a 500 Hz sound would be attenuated by 12dB. 
Every 6dB represents a halving of sound level, so the 500 Hz sound would 
appear in the recording at one-fourth (¼ or 0.25) its original amplitude. 

Do not use 16 kHz for acoustic recording; it is only useful for the SM3BAT 
unit to filter out all non-ultrasonic frequencies.  

GAIN <gain-channel-0> <gain-channel-1> 
Analog voltage gain settings. The range is 0 dB to 59.5 dB in 0.5 dB steps. 
Gain has Auto selection available. 

Gain AUTO setting behavior: 

■ Internal or external acoustic microphone on the channel: 24 dB 
■ External hydrophone on the channel: 0 dB 

TIP: If your recordings are too loud or distorted, try decreasing the GAIN value. 

FS <WAV,WAC> {OFF,0,1,0+1} <sample rate>  
Specifies the file type produced, the source channels used, and the sample 
rate for full-spectrum recordings. Channel and sample rate both have Auto 
selections available. 
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Choose the standard WAV mode for uncompressed .wav recording files. 
They consume less power and you can open them in any audio software. 
The .wac file format offers about a 40% reduction in storage, but at the 
expense of 40% more power consumption. Choose WAC for acoustic 
recordings when storage is more important than power. 

The following sample rates are available on two channels simultaneously 
unless otherwise specified: 

■ 1000 
■ 2000 
■ 4000 
■ 8000 
■ 9600 
■ 12000 
■ 16000 
■ 19200 
■ 24000 
■ 32000 
■ 48000 
■ 96000 
Choose a sample rate that is at least double the highest frequency to be 
recorded. 

The AUTO setting behavior is stereo channels at 24 kHz sample rate.  

ZC {OFF,0,1,0+1} {4,8,16}  
Specifies the source channels used and the division ratio for zero-crossing 
recordings. Channel has Auto selection available. 

NOTE: ZC recording cannot be used with the SM3 because it needs hardware 
available only in the SM3BAT model. This command must be used, however, to 
maintain program compatibility when switching between SM3 and SM3BAT models. 
ZC channel should be set to OFF or AUTO (which also selects OFF). 

TRGLVL <level-channel-0> <level-channel-1> 
Specifies the digital trigger level. Thresholds are either absolute (negative 
values) or relative to the measured noise floor (positive values). The range is 
-88 dB – +88 dB in 1-dB steps or OFF or AUTO selection is available.. 

If either channel value is not OFF, then the FRQMIN, FRQMAX, DMIN, 
DMAX, TRGWIN, and TRGMAX commands are required before the next 
RECORD command. 
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NOTE:  Triggers do not work well for most acoustic applications, but this command 
must be used to prevent an error. Off or Auto should be selected (Auto will select Off 
as well). This is to maintain cross compatibility of programs from SM3 to SM3BAT. 

RECORD hh:mm:ss 
Starts a new recording of the specified duration. If the RECORD command 
is inside a repeat/until loop, the recording may end early to match the outer 
loop ending time. 

Before a RECORD command, your program must include one of each of 
the following commands: HPF, GAIN, FS, ZC, and TRGLVL. It is not 
necessary to repeat those commands before each RECORD command, but 
you may if you wish to have different values in effect at each RECORD 
command. 

In addition, the FS command must have its channels parameter set to a 
value other than OFF. 

Recording files larger than 2.0 GB are divided into smaller segments. 

PAUSE hh:mm:ss 
Pauses the program for the specified amount of time. If you set the duration 
of the PAUSE command to greater than 1 minute (3 minutes if using the 
GPS option), the SM3 enters low-power sleep mode and wakes up at the 
next scheduled recording. 

AT DATE DDMMMYY  
Causes the program to wait until the specified date. YY are the last two 
digits of the year in the current century beginning with the year 2000.  
Alway put the AT DATE command as the first command in your program. 

NOTE: If you start the program after the specified AT DATE, the command is ignored 
and the program continues.  

AT TIME hh:mm:ss 
Causes the program to wait until the specified date time.  

NOTE: If you use an AT TIME, AT SRIS or At SSSET command and start the program 
after that time of day, the recorder will assume you wish to record starting at the 
previously occurring sunset, sunrise or time and begin recording immediately.  

For example, if you have a program that starts with AT TIME 16:00:00 and you are in 
the field starting the program at 17:00:00, the recorder will not wait until 16:00:00 the 
next day, but instead will start recording immediately. 
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AT SRIS±hh:mm:ss 
Causes the program to wait until sunrise, plus or minus the specified time.  

AT SSET±hh:mm:ss 
Causes the program to wait until sunset, plus or minus the specified time. 

REPEAT 
Indicates the beginning of a loop. Must be ended by an UNT command.  

UNTDATE DDMMMYY 
Ends a loop when the specified termination date is reached. Any RECORD 
commands in progress in this loop are forced to stop recording. 

UNTTIME hh:mm:ss 
Ends a loop when the specified termination time is reached. Any RECORD 
commands in progress in this loop are forced to stop recording. 

UNTSRIS±hh:mm:ss 
Ends a loop at sunrise, plus or minus the specified time. Any RECORD 
commands in progress in this loop are forced to stop recording. 

NOTE: Some commands listed in this section refer to sunrise or sunset in a general 
sense but depend on their precise calculated values in programs. The recorder 
recognizes different methods for calculating precise sunrise and sunset times. To 
specify a method and view the next available sunrise and sunset times, select 
Sunrise/Sunset Type in the Settings menu. 

UNTSSET±hh:mm:ss 
Ends a loop at sunset, plus or minus the specified time. Any RECORD 
commands in progress in this loop are forced to stop recording. 

UNTCOUNT {<count>, INF} 
Ends a loop after <count>iterations. INF specifies an infinite count. 

FEATURE <feature number> {OFF,ON} 
This is for advanced use only and is not a required command by the 
program checker.  The first parameter is a number from 1 to 16 and the 
second parameter is OFF or ON. By default, all features are OFF.  

■ FEATURE #01: If ON, disables the LED blinking during recording.  Insert 
into the top of a program "01 FEATURE 01 ON" to disable the LEDs. 

■ FEATURE #02: If ON, enables 32-bit recording mode. 32-bit mode is 
only enacted with very specific program settings and is intended for use 
only with SM3M Marine recorders. 
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This command may be used to add additional features in the future. 

6.3.1 Unused Commands 
The following commands are designed for the Song Meter SM3BAT Ultrasonic 
Bat Recorder. Although they can be added to your program, triggers and 
scrubbers do not work well for acoustic applications. Nap mode uses hardware in 
the SM3BAT that is not available in the SM3. 

FRQMIN <freq-channel-0> <freq-channel-1> 
Specifies the lower bound for the frequencies of interest to the scrubber 
and the triggering mechanism. 1 kHz – 192 kHz in 1-kHz steps, or OFF. 

FRQMAX <freq-channel-0> <freq-channel-1> 
Specifies the upper bound for the frequencies of interest to the scrubber 
and the triggering mechanism. 1 kHz – 192 kHz in 1-kHz steps, or OFF. 

DMIN <dur-channel-0> <dur-channel-1> 
Specifies the minimum duration for a signal in the specified frequency range 
to be a valid trigger. 0.1 – 800.0 msec in 0.1-msec steps, or OFF. 

DMAX <dur-channel-0> <dur-channel-1> 
Specifies the maximum duration for a signal in the specified frequency 
range to be a valid trigger. 0.1 msec – 800.0 msec in 0.1-msec steps, or OFF. 

TRGWIN <window-channel-0> <window-channel-1> 
Specifies the maximum recording duration in the absence of a triggering 
signal. 0.1 sec – 9.9 sec in 0.1-sec steps. 

TRGMAX <len-channel-0> <len-channel-1> 
Specifies the maximum duration for a triggered recording. 0.1 sec – 99.9 sec 
in 0.1-sec steps, or OFF. 

NAP <delay> 
Specifies how long to wait in the absence of a trigger before going into a 
lower-power state. 1 min – 99 min in 1-min steps, or OFF 

PLAY {0-9} 
Plays back the specified .wav file from the SD card in slot A. The audio is 
output through the bottom connector in the connector module. Only 
mono/stereo 16-bit uncompressed PCM recordings are supported at one of 
the supported sample rates. The filenames need to be of the form: 
CALLX.WAV where X is 0 through 9. Please contact Wildlife Acoustics 
support for technical details on outputting the signal to a playback speaker. 
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6.4 How to Work With the Program Checker  
The Program Checker runs automatically to verify the configuration of the 
hardware and software, and to check your program for errors or warnings. If it 
detects contradictory commands, the Program Checker reports the latter of the 
two as the error source. Use the Program Checker output to correct your 
program, save it, and then attempt to import or run it again. 

1. The Program Checker runs at all of the following times: 
■ After you finish loading or importing a program. 
■ After you finish editing a program and press the main buttons on 

the device to exit the editor as viewed through the LCD screen. 
■ Before you press the PROGRAM START button to run a program. 

2. The Program Checker performs several tests on the current program. For 
example, it checks for the following items: 
■ Balanced REPEAT/UNTX loops 
■ At least one RECORD or PLAY command that is reachable and 

precedes or is inside of an infinite loop. 
■ All required parameters set prior to a RECORD command. 
■ Parameters that are consistent with the present hardware. 

3. It shows errors (if any), followed by warnings (if any), and their matching 
line number in your program. 

4. To view the next error or warning, press the ▼ Down button. 
5. To exit the Program Checker, press the ◄ Left button. You can also exit by 

pressing ▼ Down after the last error or warning. 
6. If no buttons are pressed for 60 seconds while a problem is displayed, the 

Program Checker times out and exits. 
7. When the Program Checker exits: 

■ If you were loading or editing a program, you return to the main 
menu. 

■ If you were running a program and there are no errors (only 
warnings or no problems at all), your program starts. 
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6.5 How to Resolve Program Checker Errors 
When a program contains warnings, you can address them or ignore them and 
continue, the program will run with warnings. However, when a program contains 
one or more errors, it will not run. To resolve an error, edit the program and 
adjust a parameter or add, move, or delete a command line. Refer to the 
following list of the most common possible program warnings and errors. 

SM3 Program Errors and Warnings 

Message Warning/Error Explanation 

Unmatched REPEAT:  error  a REPEAT command for which no 
corresponding subsequent UNT_X command can 
be found. 

Unmatched UNTX:  error an UNT_X command for which no 
corresponding preceding REPEAT command can 
be found. 

Inf lp bfr REC/PLAY:  error  the program has an infinite loop before 
reaching any RECORD or PLAY command. 

Unreachable command:  warning  the program has commands following an 
infinite loop. 

No RECORD or PLAY:  error  the program contains neither a RECORD nor 
a PLAY command. 

No HPF cmd:  error  a RECORD command has been reached with no 
preceding HPF command. 

No GAIN cmd:  error  a RECORD command has been reached with no 
preceding GAIN command. 

No FS cmd:  error a RECORD command has been reached with no 
preceding FS command. 

No ZC cmd:  error a RECORD command has been reached with no 
preceding ZC command. 

No DTRGLVL cmd:  error  a RECORD command has been reached with no 
preceding HPF command. 

No FREQMIN cmd:  error a RECORD command has been reached, with 
triggered recording enabled, with no 
preceding FREQMIN command. 

No FREQMAX cmd:  error  a RECORD command has been reached, with 
triggered recording enabled, with no 
preceding FREQMAX command 

No DMIN cmd:  error  a RECORD command has been reached, with 
triggered recording enabled, with no 
preceding DMIN command 

No DMAX cmd:  error a RECORD command has been reached, with 
triggered recording enabled, with no 
preceding DMAX command 

No DTRGWINDOW cmd:  error  a RECORD command has been reached, with 
triggered recording enabled, with no 
preceding DTRGWINDOW command 
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Message Warning/Error Explanation 

No DTRGMAXLEN cmd:  error  a RECORD command has been reached, with 
triggered recording enabled, with no 
preceding DTRGMAXLEN command 

FREQMAX <= FREQMIN:  error  a RECORD command has been reached, and a 
channel’s preceding FREQMAX value is less 
than or equal to its preceding FREQMIN 
value. 

DMAX <= DMIN:  error  a RECORD command has been reached, and a 
channel’s preceding DMAX value is less 
than or equal to its preceding DMIN value. 

Nap not triggered:  warning  a NAP command has been reached with 
triggered recording disabled. 

Bad FS sample rate:  error  a RECORD command has been reached and the 
preceding FS command rate parameter does 
not have one of the allowed values: OFF, 
AUTO, 1000, 2000, 4000, 8000, 9600, 12000, 
16000, 19200, 24000, 32000, 48000, 96000, 
192K, 256K, 384K 

No record channels:  error  a RECORD command has been reached and the 
preceding FS and ZC commands’ channel 
parameters are all OFF. 

ZC not triggered:  error  a RECORD command has been reached, the 
preceding ZC command channel parameter is 
not OFF, and triggered recording is not 
enabled. 

Ult rate, no ult hw:  error  a RECORD command has been reached, the 
preceding FS command channel parameter is 
not OFF, and its rate parameter is greater 
than or equal to 192K. 

Using only channel 0:  run-time 
warning  

a RECORD command has been reached, an 
ultrasonic board is present, the preceding 
FS command’s channel parameter is AUTO, 
there are two external microphones, and 
the preceding FS command’s rate parameter 
is set too high for stereo for the 
command’s file type (WAV, WAC): the 
recorder will choose one channel to use 
rather than stereo, choosing whichever 
channel has an ultrasonic microphone or 
channel 0 if they both have ultrasonic 
microphones. 
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Message Warning/Error Explanation 

Using only channel 1:  run-time 
warning  

a RECORD command has been reached, an 
ultrasonic board is present, the preceding 
FS command channel parameter is AUTO, 
there are two external microphones, and 
the preceding FS command’s rate parameter 
is set too high for stereo for the 
command’s file type (WAV, WAC): the 
recorder will choose one channel to use 
rather than stereo, choosing whichever 
channel has an ultrasonic microphone or 
channel 1 if they both have ultrasonic 
microphones. 

Bad rate for stereo:  error  a RECORD command has been reached and the 
preceding FS command channel parameter is 
0+1 (stereo) and its rate parameter is set 
too high for its file type (WAV, WAC). 

No microphones:  run-time 
error  

a RECORD command has been reached, an 
ultrasonic board is present, and there are 
no external microphones attached. 

Missing microphone:  run-time 
warning  

a RECORD command has been reached, an 
ultrasonic board is present, and there is 
no external microphone on a channel 
explicitly selected (0, 1, or 0+1; not 
AUTO or OFF) in the preceding FS or ZC 
command. 

No ultra microphones:  run-time 
warning  

a RECORD command has been reached, the 
preceding FS command channel parameter is 
not OFF, its rate parameter is 192k or 
greater, and only external acoustic 
microphones are connected. 

Acous rate ultr mics:  run-time 
warning  

a RECORD command has been reached, the 
preceding FS command channel parameter is 
not OFF, its rate parameter is less than 
96000, and only ultrasonic microphones are 
connected. 

HPF 16K, no ult hw:  error  a RECORD command has been reached, an 
ultrasonic board is not present, and the 
preceding HPF command has one or both 
channels set to 16K. 

HPF 16K, acoust rate:  error  a RECORD command has been reached, the 
preceding FS command rate parameter is 
less than 192k, and the preceding HPF 
command has one or both channels set to 
16K. 

Bad ZC gain:  error  a RECORD command has been reached, an 
ultrasonic board is present, the preceding 
ZC command has a channel enabled (either 
explicitly at any time or via AUTO 
selection at run time), and the preceding 
GAIN command value for that channel is 
neither 0 nor 12 dB. 
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Message Warning/Error Explanation 

Bad FS ultra gain:  error  a RECORD command has been reached, an 
ultrasonic board is present, the preceding 
FS command has a channel enabled (either 
explicitly at any time or via AUTO 
selection at run time) and a rate greater 
than 96000, and the preceding GAIN command 
value for that channel is neither 0 nor 12 
dB. 

ZC, no ult hw:  error  a RECORD command has been reached, an 
ultrasonic board is not present, and the 
preceding ZC command channel parameter is 
not OFF. 

ZC acoust mic no FS:  run-time 
warning  

a RECORD command has been reached, an 
ultrasonic board is present, the preceding 
ZC command has a channel enabled (either 
explicitly or via AUTO selection) and the 
preceding FS command does not have that 
same channel enabled (either explicitly or 
via AUTO selection), and an external 
acoustic microphone is attached to that 
channel. 

Ultra mic no ultr hw:  run-time 
warning  

a RECORD command has been reached, an 
ultrasonic board is not present, the 
preceding FS command channel parameter is 
not OFF and its rate parameter is AUTO, 
and at least one external ultrasonic 
microphone is connected. 

Ext acst & ultr mics:  run-time 
warning  

a RECORD command has been reached, the 
preceding FS command channel parameter is 
not OFF and its rate parameter is AUTO, 
and an external ultrasonic microphone is 
connected to one channel and an external 
acoustic microphone is connected to the 
other channel. 

Can't open play file:  run-time 
error  

a PLAY command has been reached and there 
is a failure accessing the SD card in slot 
A or a failure opening the desired file on 
the card. 
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7 Managing Deployments 
Recording time is determined by the demands of your program and the available 
power and memory resources required to carry out the recordings. The SM3 can 
only record while it has sufficient power available in the batteries and room to 
save recordings on SD memory cards. Download our free SM3 Configurator 
software application to see detailed visual forecasts for remaining battery life and 
memory card utilization given your specific recording schedule and 
configuration. 

7.1 How to Estimate Battery Life 
In sleep mode between scheduled recordings, the SM3 uses almost no power 
(around 0.5 mW) so it can remain idle (not recording) for months at a time. 
However, the batteries will discharge on their own over time. When recording, 
depending on accessories, sample rates, compression, and other variables, the 
SM3 can use as little as 250 mW current. That translates to almost 260 hours of 
recording time using high-quality alkaline batteries. Use the SM3 Configurator to 
estimate a recording schedule based on your program requirements. 

7.2 How to Estimate Memory Requirements 
Recordings consume 2 bytes (16-bits) per sample, times the sample rate, times 
the number of channels per second. For example, a recording made at a 
sampling rate of 24,000 samples per second in stereo (2 channels) consumes 2 x 
24,000 x 2 = 96,000 bytes per second. With 128 GB total capacity, an SD memory 
card of this size can record up to 128,000,000,000 divided by 96,000 = 1,333,333 
seconds, or about 370 hours of recording time. 

NOTE: The largest recording file size allowed is 2.0 GB. The recorder automatically 
breaks up large recordings into smaller segments to satisfy this requirement. 

In most applications, there is no reason to use sampling rates faster than twice 
the frequencies of interest. The majority of frog vocalizations are under 4 kHz and 
need only be sampled at 8 kHz while most bird vocalizations are under 8 kHz and 
need only be sampled at 16 kHz (with the exception of some high-pitched 
warblers who sing at 12 kHz and need to be sampled at 24 kHz). 

The following tables estimate the recording time in hours for different 
combinations of memory capacity, sample rates, and channels: 
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Estimated Recording Time in Hours [Mono (1 channel)] 

 96,000 48,000 44,100 32,000 24,000 22,050 16,000 8,000 4,000 
8 GB 11.6 23.1 25.2 34.7 46.3 50.4 69.4 138.9 277.8 

16 GB 23.1 46.3 50.4 69.4 92.6 100.8 138.9 277.8 555.6 

32 GB 46.3 92.6 100.8 138.9 185.2 201.6 277.8 555.6 1111.1 

64 GB 92.6 185.2 201.6 277.8 370.4 403.1 555.6 1111.1 2222.2 

128 GB 185.2 370.4 403.1 555.6 740.7 806.2 1111.1 2222.2 4444.4 

256 GB 370.4 740.8 806.4 1111.2 1481.6 1612.4 2222.4 4444.4 8888.8 

 

Estimated Recording Time in Hours [Stereo (2 channels)] 

 96,000 48,000 44,100 32,000 24,000 22,050 16,000 8,000 4,000 
8 GB 5.8 11.6 12.6 17.4 23.1 25.2 34.7 69.4 138.9 

16 GB 11.6 23.1 25.2 34.7 46.3 50.4 69.4 138.9 277.8 

32 GB 23.1 46.3 50.4 69.4 92.6 100.8 138.9 277.8 555.6 

64 GB 46.3 92.6 100.8 138.9 185.2 201.6 277.8 555.6 1111.1 

128 GB 92.6 185.2 201.6 277.8 370.4 403.1 555.6 1111.1 2222.2 

256 GB 185.2 370.4 403.2 555.6 740.8 806.2 1111.2 2222.2 4444.4 

If you enable compression, you can typically increase recording capacity by 40% 
(compression rates vary with sample rates and site-specific ambient sound levels).  

NOTE: Compression consumes more processing power and offers decreased value as 
memory card prices fall while capacities continue to grow. For most wildlife recording 
projects, we recommend .wav format. 
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8 Audio Recordings 

8.1 Filenames for Recordings 
Audio recording files are saved in a Data folder on each memory card and use 
the following naming conventions: 

PREFIX_XXX_YYYYMMDD_HHMMSS.wav  
 

PREFIX 

The prefix set by the program file or the SM3 hardware. 

XXX 

The channel indicator for each recording. Possible values include: 

■ _0_ Mono on channel 0. 
■ _1_ Mono on channel 1. 
■ 0+1 Stereo (both channel 0 and 1). 

YYYYMMDD_HHMMSS 

The full timestamp including the year, month, day, hour, minute, and second 
when the recording started. 

.wav 

The filename suffix. 

■ .wav for uncompressed files. 
■ .wac for the proprietary lossless audio compression format. 

NOTE: If your recording was saved from a device with a GPS synchronization 
capability, the file name shows a $ between the date and time. For example: 

 ARIZONA-1234_0+1_20161023$195550.wac  
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8.2 Recording Metadata 
Values for the attributes listed below are stored as metadata in your recording 
files when recording in .wav format. These metadata tags are helpful in compiling 
metrics or troubleshooting issues, especially in multi-unit deployments. For 
example, recordings from a specific device, identified by serial number, can be 
traced to determine what settings and programs were used during the recording.  

Some of the metadata information is visible in the available Kaleidoscope 
software. Kaleidoscope has the ability to add further metadata relating to analysis 
of the recording. 

NOTE: Some of the metadata tags described below are only used by Wildlife 
Acoustics for diagnostics, while others may be used to provide future capabilities and 
are not currently available. 

Device Model 

The device model, example SM3 or SM3BAT. 

Device Serial Number 

The unique serial number for your recorder. 

Firmware Version 

The firmware version installed on the source recorder. 

Device Name  

The prefix assigned on the recorder under the Settings menu. 

Timestamp 

The date and time when the recording started. 

GPS Coordinates 

The location of the Song Meter when recording first started. 

Program and Settings 

A block of metadata containing the entire program and settings. 

TIP: Open the recording in the SM3 Configurator to view the program and settings 
used to make the recording. 
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8.3 Summary Text Files 
Once per minute during a recording, and when each recording file ends, the SM3 
appends a line of text to the summary text (.txt) file. It is in comma-separated 
values (CSV) format and you can open it in Microsoft Excel or in a text editor. The 
file begins with a header line which identifies the fields that appear in each line of 
summary data in the rest of the file: 
DATE,TIME,LAT,,LON,,STEP,POWER(V),TEMP(C),#FILES,#SCRUBBED,MIC0 
TYPE,MIC0 TRIGGERS,MIC0 ZCFILES,MIC1 TYPE,MIC1 TRIGGERS,MIC1 ZCFILES 

As examples, three lines from a sample summary file appear below: 
2016-Jan-22,17:15:24,42.00000,N,71.00000,W,0.000000,5.9,12.00,2,1,U1,29,0,U1,19,0  
2016-Jan-22,17:16:38,42.20000,N,71.10000,W,0.000000,5.9,11.75,3,4,U1,34,0,U1,21,0  
2016-Jan-22,17:17:47,42.35000,N,71.18200,W,0.300000,5.5,11.75,1,2,U1,21,0,U1,11,0 

 

Date 

The date for these entries was January 22, 2016.  

Time 

The current local time for each entry appears about one minute from the 
last entry.  

NOTE: The date, time, and time zone are set on the recorder. 

Latitude and Longitude 

If the GPS receiver is installed, the coordinates are given.  

Step 

The step represents the drift between the GPS time base and internal real 
time clock. It is only useful for advanced time synchronization calculations. 

Power 

The power supply voltage for the internal batteries or an external power 
source appears. 

Temperature 

In our example, the internal temperature has fallen from 12.0 to 11.75 
degrees Celsius. 

Number of Files and Scrubbed Files 

The values 2, 3, and 1 represent the number of recording files written since 
the previous summary line. 

The values 1, 4, and 2 represent the number of files scrubbed since the 
previous summary line. 
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Channel 0 Microphone Type, Triggers, and ZC Files 

The channel 0 microphone type: A1, U1, H1, or NA if no microphone is 
connected on that channel or if channel 0 has been set to an internal mic. 

The number of channel 0 triggers detected in triggered mode. A zero (0) 
appears for continuous mode. 

The number of zero crossing files written on channel 0. A zero (0) appears 
when you are not recording in ZC mode. 

Channel 1 Microphone Type, Triggers, and ZC Files 

The channel 1 microphone type: A1, U1, H1, or NA if no microphone is 
connected on that channel or if channel 1 has been set to an internal mic. 

The number of channel 1 triggers detected in triggered mode. A zero (0) 
appears for continuous mode. 

The number of zero crossing files written on channel 1. A zero (0) appears 
when you are not recording in ZC mode. 

8.4 How to Install the Kaleidoscope Software 
The free version of this post-processing software from Wildlife Acoustics can 
convert compressed .wac files to standard .wav files quickly and easily.  

1. Navigate to www.wildlifeacoustics.com/support/download-software. 
2. Find the file appropriate for your operating system. 
3. On Windows, open file and follow installation instructions. On Mac copy 

the file to the Applications folder. 
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9 Utilities 

9.1 How to Erase and Format SD Memory Cards 
This procedure erases and formats all installed memory cards. Use this procedure 
prior to all deployments for optimal performance.  

WARNING: This procedure erases all data files on all memory cards in all slots. Verify 
that you have imported, saved, or copied any important programs, backed up any 
important recordings, and updated any firmware files before running this utility. 

1. At the Song Meter Main Menu, select Utilities, and press ENTER/MENU. 
2. Select Format all cards and press ENTER/MENU. 
3. At the Confirm: Format All? prompt, choose one of the following options: 

■ Press ► Right to select No and cancel this entire procedure. Any 
existing data files remain on the memory cards. 

■ Press ▼ Down to select Yes and press ENTER/MENU to format all 
current memory cards in slots A, B, C, and D. 

4. If you select Yes, the progress of each card in each slot appears and then 
the screen resets to the last selected submenu. 

5. With up to four clean formatted memory cards, you now have the 
maximum available space on all cards and are ready to start a program 
and save recordings. 

9.2 How to Reset Factory Default Settings 
This short procedure restores the original device settings set as default values in 
the factory when your recorder was first assembled and tested. 

1. At the Song Meter Main Menu, select Utilities, and press ENTER/MENU. 
2. Select Set factory default and then press ENTER/MENU. 
3. The original settings are restored. 

CAUTION: Any custom settings, including solar calculation method, location, and 
prefix, are erased. 
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9.3 How to Measure Microphone Sensitivity 
You can view and verify the sensitivity of acoustic microphones. This utility 
displays dB (re full scale).  

1. At the Song Meter Main Menu, select Utilities, and press ENTER/MENU. 
2. Select Calibrate Mics and then press ENTER/MENU. 

MICROPHONE CALIBRATE 
       @1     @40 kHz 
Ch 0: -62.4  -73.8 dB 
Ch 1: -62.5  -73.6 dB 

a. The values under @1 represent levels at 1 kHz, a good measure of 
acoustic sensitivity.  

b. The values under @40 are for testing the SM3BAT recorder. 
3. Press ENTER/MENU when finished. 

 

To test SMM-A1 microphones, you can also generate a 1 kHz signal with a 
professional microphone calibrator (which slides over the mic), or use a signal 
generation smartphone app played in proximity. To set both microphones at 
approximately the same sensitivity, adjust the GAIN level in your program to 
better match the microphones. 

9.4 How to Update the Firmware 
When a new firmware update is available, download and install it to update your 
recorder components. You must register online to access the downloads. 

1. On your computer or mobile device, open a web browser. 
2. Navigate to www.wildlifeacoustics.com. 
3. Click Support and then click Downloads. 
4. Complete the online form and click Request Downloads. 
5. Select the latest SM3 firmware update file to download it. 
6. (Optional) As a registered user, you can also access the following 

downloads: 
■ SM3 Configurator software 
■ Kaleidoscope software for sound file conversions 
■ Song Scope software 
■ Firmware for other devices such as Echo Meter or SM2 

7. Save or copy the .SM3 firmware file to the top level of an SD card. 
8. Turn each of the four thumb-screws  counterclockwise and remove the 

cover to the memory bay. 
9. Insert the SD card into slot A of the SM3 recorder. 
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NOTE: Perform all firmware updates on an SD card in memory slot A.  
The Firmware Update menu option waits for a card to be inserted in slot A. 

10. At the Song Meter Main Menu, press ▼ Down to select Utilities and 
then press ENTER/MENU. 

11. Press ▼Down to select Firmware Update and then press ENTER/MENU. 

NOTE: You can also press and hold ▲Up while powering the unit ON to activate the 
firmware update menu.  

12. The SM3 scans your SD card in slot A for valid .SM3 files. 
13. At the Select upgrade file prompt, select the firmware update file that you 

want to apply and press ENTER/MENU. The following message appears: 
Upgrading.......... 
 
UPGRADE COMPLETE 
Rebooting 

The system applies the new firmware and restarts. 

9.5 How to Generate Diagnostics 
Use this procedure to generate diagnostic information about the current state of 
the recorder. Use the diagnostic information to troubleshoot any problems you 
may be experiencing. When contacting customer support, a representative may 
ask you to provide this information to diagnose the problem. 

1. Insert at least one SD card into the SM3 recorder. 
2. At the Song Meter Main Menu, select Utilities, and press ENTER/MENU. 
3. Select Export Diagnostics and then press ENTER/MENU. 
4. The unit performs audio path tests and then exports the following 

information in a log file to the first available SD card: 
■ current settings 
■ current configurations 
■ current program 
■ other diagnostic information 

Note: You can also press and hold ▼Down while powering the unit ON to activate the 
diagnostics utility. 

The diagnostic file name ends in an sm3dump extension and includes the 
location prefix, date, and time. For example: 

ARIZONA-1234_20160106_215045.sm3dump 



SM3 Specifications SM3 User Guide 
 

 

page 54   
    BIOACOUSTIC MONITORING SYSTEMS 

10 SM3 Specifications 

10.1 Physical  

 
 

 
SM3 Physical Specifications 

Length/Height: 12.75 inches (32.4 cm) 

Width: 7.875 inches (20.0 cm) 

Depth (Upper): 2.31 inches (58.7 cm) 

Depth (Lower): 2.56 inches (65.0 cm) 

Weight: 5.5 pounds (2.5 kg) 

Weight (with 4 Batteries): 7.0 pounds (3.2 kg)  

Operating Temperature: -4°F to 122°F (-20°C to 50°C) 
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1.000 2.54

1.750 4.45

5.810 14.76

.335 0.85

4X .200 0.51 .375 0.95
.380 0.97

.188 0.48 .540 1.37

11.948 30.35
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10.2 Power 
Main Power:  4.5 - 17V DC (4 internal D-size batteries) 

External power connector: 4.5 - 17V DC  

Clock Back-up Battery Type: CR2032 (up to 8-year life) 

Power consumption: 0.5 mW (sleeping); 250 – 500 mW (recording) 

Battery Specifications: The SM3 uses four (4) standard D size disposable alkaline 
batteries or rechargeable NiMH batteries. Battery life can vary widely depending 
on the battery type, brand, charger, temperature, and other factors. The following 
battery life cycles are typical: 

■ Alkaline batteries: 260 hours 
(assuming 12,000 milliamp hours at 1.5V each) 

■ NiMH batteries: 180 hours 
(assuming 10,000 milliamp hour batteries at 1.2V each) 

10.3 Memory Cards 
The four (4) card slots can be populated with at least one (1) and up to four (4) 
memory cards of assorted capacities. The device supports all class 4 or faster 
SDHC or SDXC cards. 

Memory Sizes: Up to 1.0 terabyte (1024 gigabytes) supported total capacity 
using 256 GB SDXC memory cards for all four (4) memory slots. This is the 
maximum currently available; higher capacities may be available in the future. 

Formats: FAT32 for SDHC or exFAT for SDXC 

Compression typically increases effective capacity by 40%. 

10.4 Audio 
Channels: 2 

Recording format: 16-bit PCM .wav or optional .wac proprietary lossless 
compressed format 

Analog to Digital Converter: 0.707V RMS (2v p-p) full-scale 

Amplifier Gain: 0.0 – 59.5 dB in 0.5-dB steps 

Noise Floor: -134 dBfs/sqrt(Hz) @48kHz rate, 1K input impedance, 0dB gain 

High Pass Filter: Optional 2-pole at 220 Hz or 1 kHz 
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Sample Rates: The recorder supports the following sample rates in samples per 
second and on one or two channels: 

■ 1000 
■ 2000 
■ 4000 
■ 8000 
■ 9600 
■ 12000 
■ 16000 
■ 19200 
■ 24000 
■ 32000 
■ 48000 
■ 96000 

Anti-alias filter gain: 

■ From 0 to 0.39 sample rate: ±0.1 dB 
■ At 0.4125 sample rate:   –0.25 dB 
■ At 0.45 sample rate:  –3 dB 
■ At 0.5 sample rate:  –17.5 dB 
■ From 0.55 to 64 sample rate:  –75 dB 

10.5 Microphones 
Types Supported: SMM-A1 external microphone and built-in microphones 

Enclosure: Weatherproof 

Sensitivity: -11±4dB (0dB=1V/pa@1KHz) 

Signal-to-Noise Ratio: > 68dB 

Dynamic Range: 26dB - 102dB SPL at 0dB gain 

Directionality: Omnidirectional 

Frequency response: Flat (+/-10dB) from acoustic to 20kHz 
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11 Warranty and Disclosures 
Except as specifically provided herein, Wildlife Acoustics makes no warranty of any kind, 
express or implied, with respect to this product. 

11.1 Wildlife Acoustics, Inc. Limited Warranty 
Hardware: Wildlife Acoustics, Inc. (“WAI”) warrants to the original end user (“Customer”) 
that new WAI branded products will be free from defects in workmanship and materials, 
under normal use. Refer to the following table for the applicable warranty period from the 
original date of purchase. 
 

Hardware Limited Warranty 
Product Components Hardware Warranty Period 
SM3 and SM3BAT 
Recorders 

All components (excluding microphones, 
batteries, and accessories) 

3 Years 

SM3 and SM3BAT 
Recorders 

Microphones, batteries, and accessories 1 Year 

Other WAI 
products 

All components  1 Year 

 
WAI warrants refurbished WAI products, marked and sold as such, for ninety (90) days from 
the original purchase date. 
 
Software: WAI warrants to Customer that any WAI branded software will perform in 
substantial conformance to their program specifications for a period of ninety (90) days from 
the date of original purchase. WAI warrants the media containing software against failure 
during the warranty period. WAI makes no warranty or representation that the operation of 
the software products will be uninterrupted or error free, or that all defects in the software 
products will be corrected. 
 
Exclusions: This warranty excludes (1) physical damage to the surface of the product, 
including cracks or scratches on the outside casing; (2) damage caused by misuse, neglect, 
improper installation or testing, unauthorized attempts to open, repair, or modify the 
product, or any other cause beyond the range of the intended use; (3) damage caused by 
accident, fire, power changes, other hazards, or acts of God; or (4) use of the product with 
any non-WAI device or service if such device or service causes the problem. 
 
Any third party products, including software, included with WAI products are not covered by 
this WAI warranty and WAI makes no representations or warranties on behalf of such third 
parties. Any warranty on such products is from the supplier or licensor of the product. 
 
No warranty is provided by WAI unless the product was purchased from an authorized 
distributor or authorized reseller. 
 
Exclusive Remedies: Should a covered defect occur during the warranty period and you 
notify WAI, your sole and exclusive remedy shall be, at WAI’s sole option and expense, to 
repair or replace the product or software. If WAI cannot reasonably repair nor replace then 
WAI may, in its sole discretion, refund the purchase price paid for the product. Replacement 
products or parts may be new or reconditioned or comparable versions of the defective item. 
WAI warrants any replaced or repaired product, part, or software for a period of ninety (90) 
days from shipment, or through the end of the original warranty, whichever is longer. 
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Obtaining Warranty Service: Customer should refer to the WAI website at 
www.wildlifeacoustics.com/support/contact-support for information on obtaining warranty 
service authorization. Methods for obtaining warranty service may vary depending on 
whether purchases were made from an authorized provider of WAI products or from WAI 
directly. All requests for warranty service authorization must be made within the applicable 
warranty period. Dated proof of original purchase will be required. Products or parts shipped 
by Customer to WAI must be sent postage-paid and packaged appropriately for safe 
shipment. WAI is not responsible for Customer products received without a warranty service 
authorization and may be rejected. Repaired or replacement products will be shipped to 
Customer at WAI expense. All products or parts that are replaced become the property of 
WAI. WAI shall not be responsible for Customer software, firmware, information, or memory 
data contained in, stored on, or integrated with any products returned to WAI for repair, 
whether under warranty or not. The repair and replacement process for products or parts in 
locations outside of the United States will vary depending on Customer’s location. 
 
Warranties Exclusive: THE FOREGOING WARRANTIES AND REMEDIES ARE EXCLUSIVE AND IN 
LIEU OF ALL OTHER WARRANTIES, TERMS OR CONDITIONS, EXPRESS, IMPLIED OR 
STATUTORY, INCLUDING WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE, ACCURACY, CORRESPONDENCE WITH DESCRIPTION, SATISFACTORY QUALITY AND 
NON-INFRINGEMENT, ALL OF WHICH ARE EXPRESSLY DISCLAIMED BY WAI AND ITS 
SUPPLIERS. 
 
Limitations of Liability: NEITHER WAI NOR ITS SUPPLIERS SHALL BE LIABLE FOR INCIDENTAL, 
CONSEQUENTIAL, INDIRECT, SPECIAL, OR PUNITIVE DAMAGES OF ANY KIND, LOSS OF 
INFORMATION OR DATA, LOSS OF REVENUE, LOSS OF BUSINESS OR OTHER FINANCIAL LOSS 
ARISING OUT OF OR IN CONNECTION WITH THE SALE OR USE OF THIS PRODUCT, WHETHER 
BASED IN CONTRACT, TORT (INCLUDING NEGLIGENCE), STRICT PRODUCT LIABILITY OR ANY 
OTHER THEORY, EVEN IF WAI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES 
AND EVEN IF ANY LIMITED REMEDY SPECIFIED IN THIS LICENSE AGREEMENT IS DEEMED TO 
HAVE FAILED OF ITS ESSENTIAL PURPOSE. WAI’S ENTIRE LIABILITY SHALL BE LIMITED TO 
REPLACEMENT, REPAIR, OR REFUND OF THE PURCHASE PRICE PAID, AT WAI’S OPTION. IN NO 
EVENT SHALL WAI’S LIABILITY FOR ALL DAMAGES RELATED TO THE PURCHASE OF PRODUCT 
EXCEED THE AMOUNT PAID FOR THE APPLICABLE PRODUCT. THE FOREGOING LIMITATIONS 
WILL APPLY EVEN IF THE ABOVE STATED REMEDY FAILS OF ITS ESSENTIAL PURPOSE. 
 
Disclaimer: Some countries, states, or provinces do not allow the exclusion or limitation of 
implied warranties or the limitation of incidental or consequential damages so the above 
limitations and exclusions may be limited in their application to you. When implied 
warranties may not be excluded in their entirety, they will be limited to the duration of the 
applicable written warranty. This warranty gives you specific legal rights; you may have other 
rights that may vary depending on local law. Your statutory rights are not affected. 
 
Governing Law: This Limited Warranty shall be governed by the laws of the Commonwealth 
of Massachusetts, U.S.A., and by the laws of the United States, excluding their conflicts of 
laws principles. The United Nations Convention on Contracts for the International Sale of 
Goods is hereby excluded in its entirety from application to this Limited Warranty. 
 
Wildlife Acoustics, Inc. 
3 Clock Tower Place, Suite 210 
Maynard, MA 01754-2549 United States of America 
www.wildlifeacoustics.com 
 
February 26, 2014 
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11.2 Declaration of Conformity (EN 45014) 
Manufacturer:  Wildlife Acoustics, Inc.  
 3 Clock Tower Place, Suite 210 
 Maynard, MA 01754 
 United States of America 
  
 
Declares that the following product:  
 Product Name: Song Meter  
 Product Model Number: SM3 
 Product Type: Bioacoustics Recorder 
 
Conforms to the appropriate country standards and governing regulations listed below 
and/or on the following page. As the manufacturer, we are fully responsible for the design 
and production of the above-mentioned equipment. 
 
Federal Communications Commission Rules Part 15, Class A 
 
AS/NZS CISPR 11, 2011, Industrial, scientific and medical (ISM) radio-frequency equipment – 
electromagnetic disturbance characteristics – limits and methods of measurement, Class A 
 
EN 55011, 2009/A1, 2010, Industrial, scientific and medical (ISM) radio-frequency equipment 
– Electromagnetic disturbance characteristics – Limits and methods of measurement, Class A 
 
ICES-003, 2004, Industry Canada, Interference-Causing Equipment Standard, Digital 
Apparatus, Class A 
 
EN61326, 2006 Electrical Equipment for Measurement, Control and Laboratory use EMC 
Requirements (EMC Directive 2004/108/EC) 
 
EN61000-4-2 Electrostatic Discharge 
 
EN61000-4-3 Radiated Electromagnetic Fields 
 
IEC 60529 Sect. 14.2.5 IPX5, 2002 (Water Jet Test) 
 
IEC 60529 Sect. 14.2.6 IPX6, 2002 (Water Jet Test) 
 
MIL-STD-810G Method 514.6 (US Highway Vibration Test) 
 
ISTA 1A (vibration and shock/drop testing) 
 
Additionally this product was tested at operating temperatures of -20C to +55C. Testing 
included 24-hour soaks at both extremes plus 6 cycles for one hour each between extremes. 
 
Tested operating humidity 95% RH at +40C. Testing included 24-hour soak. 
 
This product was tested in a typical configuration. 

 
Ian Agranat, President 
Wildlife Acoustics, Inc. 
March 1, 2014 
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11.3 Prohibition Against Eavesdropping 
United States law (Federal Communications Commission Part 15 Section 15.9) states “Except 
for the operations of law enforcement officers conducted under lawful authority, no person 
shall use, either directly or indirectly, a device operated pursuant to the provisions of this 
Part for the purpose of overhearing or recording the private conversations of others unless 
such use is authorized by all of the parties engaging in the conversation.” 
 
You are responsible for complying with all applicable laws within your jurisdiction. 

11.4 Electromagnetic Interference 
This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules.  
 
These limits are designed to provide reasonable protection against harmful interference 
when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance 
with the instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference in 
which case the user will be required to correct the interference at his own expense. 
 
Changes or modifications not expressly approved by Wildlife Acoustics, Inc., could void the 
user's authority to operate the equipment. 
 
Note: Use of ferrite clamped cables are required to comply with the Class A limits in part 15 
of the FCC rules. A Fair-Rite 0431164181 ferrite clamp (or equivalent) must be placed on each 
cable near the recorder with the ferrite residing within one loop of the cable. 
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